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Section 1 Introduction
Outlook 2010 is a powerful Information management application that allows you to co-ordinate projects using a variety of
different tools. These range from E-mail for communication, to the Calendar, which can be used for time management.
Tasks to manage your workload and notes to stop you forgetting important bits of information, Finally contacts to keep
a track of all the people you need to incorporate into your busy schedule either by phone, email projects, mailings or
social connections.
All graphics related to Microsoft in this book is in compliance with Microsoft guidelines and thus permitted by Microsoft.

How To Use This Guide
This manual should be used as a point of reference following attendance of the Outlook ’2010 training course. It covers
all the topics taught and aims to act as a support aid for any tasks carried out by the user after the course.
The manual is divided into sections, each section covering an aspect of the course. The table of contents lists the page
numbers of each section and the table of figures indicates the pages containing tables and diagrams.

Objectives
Sections begin with a list of objectives each with its own check box so that you can mark off those topics that you are
familiar with following the training.

Instructions
Those who have already used a similar application before may not need to read explanations on what each command
does, but would rather skip straight to the instructions to find out how to do it. Look out for the hand icon which
precedes a list of instructions.

Keyboard
Keys are referred to throughout the manual in the following way:
[ENTER] – denotes the return or enter key, [DELETE] – denotes the Delete key and so on.
Where a command requires two keys to be pressed, the manual displays this as follows:
[CTRL][P] – this means press the letter “p” while holding down the Control key.

Commands
When a command is referred to in the manual, the following distinctions have been made:
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When ribbon commands are referred to, the manual will refer you to the ribbon – “Choose message ribbon and then
basic text group and then the command”.

Notes
Within each section, any items that need further explanation or extra attention devoted to them are denoted by shading.
For example:
“Outlook will not let you close a mail message that you haven’t already saved without prompting you to save.”
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Section 2	Understanding Outlook
2010
Objectives:
By the end of this section you will be able to:
•

Understand The Uses Of Microsoft Outlook

•

Get Started

•

Recognise Outlook Screen Elements

•

Access Help
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What is Microsoft Outlook 2010?
Outlook ’2010 is an information management application that helps the user to co-ordinate messages, calendar activities,
contacts and tasks. It comprises a mailbox, a calendar, a contact list, notes and a journal. Outlook is designed for both
stand-alone computers and personal computer networks. If the user is connected to a network they can share their
information with others.
Outlook comes with a transport application known as Exchange. A transport application enables the flow of information
and must be installed to use Outlook’s e-mail feature. E-mail is sent in and out of mailboxes in the same way as physical
mail goes through a postal service. Mailboxes can be set up for individual users or for multiple users. All networked
users with mail accounts can share information by using Outlook and a transport application such as Exchange.

Getting Started With Outlook 2010
When Outlook 2010 is installed, the Setup program looks for the user’s user profile. A user profile is a group of settings
that define the setup of Outlook for a particular user. Only one user profile is needed to access Outlook, however, multiple
user profiles can be set up each with their own unique settings,
E.G. if there is more than one person using Outlook, each user should have their own user profile set up. The user’s
administrator usually creates user profiles.
When setting up user profiles, certain information services can be included. An information service is a group of settings
that enables the user to send, store and receive messages and items, and indicates where to store addresses,
E.G. in a Personal Address Book.

Logging On
When Outlook 2010 is launched, depending on the configuration, the user may be asked to enter a password.
➢➢ To Enter A Password:
Keyboard
1. Type the relevant password
2. Press [ENTER]
3. Outlook is started with the users identity on the top of their mailbox on the left.

The Outlook 2010 Screen
When Outlook 2010 is first started, the user is presented with the following screen:
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Title Bar And Buttons

The Title Bar appears at the top of the Outlook window, registering the title of the application the selected Outlook folder
and the user, (if connected to exchange). When the Outlook window is not maximised, you are able, by positioning the
mouse over the title bar and clicking and dragging, to move the window to a new location on the screen.

Maximise Button

When working in Outlook, the Outlook screen may not be a full size window If you would like the window that your
Outlook application is in to fill up the whole screen, click the outermost maximise button.

Minimise Button
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This button is very useful if you need to temporarily switch from Outlook into another application without closing Outlook
down completely. Click the minimise button to shrink Outlook to an icon on the task bar; you will then be able to view
other icons and applications you may wish to access. When you are finished and ready to continue, click the Outlook
icon from the task bar to resume.

Restore Button
This button only appears when a window is maximised. A maximised window has no border and you cannot see what is
behind it. If you want to put the window back inside its border so that you can move and size it, click the restore button.

Close Button

This button is used to close a window. If you click the close button it will close the Outlook application.

Menus
Menu’s are no longer used in Outlook they have been replaced by Ribbons and will be referred to as such throughout
the manual
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Ribbons

Ribbons are tabs that show different commands with respect to what you wish to do the home ribbon shows basic
commands of email.
The send and recieveribbon gives commands on sending your emails remember outlook may be used with exchange, POP
email and Dial-up as a few examples. Just click on any named ribbon to see list of commands that you can perform by
clicking on the appropriate icon.
The commands on the ribbons will change depending on whether you are in mail, calendar, tasks etc.
Any Icon on the ribbon with a down arrow offers other options and sometimes a dialog box.
E.G. Choosing quick parts in the text group allows you to insert a field within your document or a document
property adding information to your document that can be updated as the information is changed at source.

Backstage View
The File Ribbon is the “tools” of Outlook and has many important commands and options. Such as Outlook settings,
opening, saving, printing and closing items. This will be looked into much further later in the manual.

Screentips
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Screentips are helpful hints that appear, to guide your choice to which command you may wish to apply. These can be
useful when locating unfamiliar buttons or commands.
➢➢ To View Screentips
Mouse
1. By holding your mouse over an icon, a helpful hint will appear to show you what that command will do.
2. Clicking will apply that command

Dialog Box

Look at a group type on the ribbon in an email such as font and in the bottom right hand corner of that group you
may see a small box with an arrow,this is thedialog box launcher clicking this is a method to call up a dialog
box when the dialog box is open, make a choice from the various options and click ok at the bottom of the dialog box.
If you wish to change your mind and close the dialog box without making a choice then click on cancel. The dialog
box will close without any choice being applied. If you would like help while the dialog box is open then click on the “?
“ in the top right hand corner this will bring up a help window that will display the relevant topics. Many dialog boxes
may be more familiar if you have used Word before.

Toolbars
There are only two toolbars within the new version of Outlook 2010 there is the quick access toolbar seen
here above the File tab, and there is the mini toolbar
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Quick Access Toolbar
By default there are only two buttons on the quick access toolbarin outlookbut these can be edited and other
regularly used buttons can be placed there. Using the drop down menu next to the quick access toolbar will
allow the customisation of this toolbar adding your most often used commands.
➢➢ To Add A Button To Quick Access Toolbar
Mouse
1. Click on drop down customisation menu for toolbar
2. Select a button to add (let’s say the new button) the New button appears in quick access toolbar
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Mini Toolbar
Whenever text is selected within an email a small formatting toolbar will appear above the highlighted text it will
disappear if the mouse cursor is moved away from the toolbar and will reappear when the mouse cursor is moved over
the highlighted text again.

Status Bar

The Status bar, across the bottom of the screen, displays different information at different times. To the right of the status
bar are firstly, the different views that can be used within Outlook, and on the far right, the zoom control

To Do Bar
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The To Do Bar is a pane on the right that allows you to quickly see appointments, tasks and a small calendar to allow you
to organise yourself quickly and easily. Showing upcoming appointments and tasks. It quickly allows you to create new
tasks and see flagged emails (emails marked for action).no matter where they are within your mailbox.
You are able to minimise or turn features on or off for this bar by going to the view ribbon and selecting the drop down
arrow on the to do bar.
Untick an item to hide it or tick to enable the feature.

Smart Tags
Smart Tags, first introduced in Microsoft Office XP, make it easier for you to complete some of the most common tasks
and provide you with more control over automatic features. Word can recognise a wide range of different data types
entered into a document, such as dates, addresses and stock ticker symbols. It converts each recognised piece of data into
a smart tag, and you can then use a menu attached to the smart tag to perform useful actions on that data. Before you
start using smart tags, you need to check if smart tags are enabled and specific smart tag recognisers are also activated.
•

You do not have to complete any additional steps to make the Smart Tags appear or disappear in Word.

E.G. The Paste Options smart tag appears automatically after pasting to allow you to quickly choose actions and
remain in place until you begin another action. When you complete a paste operation, the Paste Options button
remains in place alongside your text until you begin typing new text.
This feature alerts you via a smart Tag of the paste options when pasting text into your email Click on the drop down
arrow to access the options
•

If you type any character the smart tag will no longer be available and will disappear

Scrollbars
The Scrollbars are located along the right and bottom of the object window. They enable you to see other parts of hidden
text or hidden emails by dragging the box or clicking the arrows in the scroll bar.
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Viewing Information In Outlook
Items
Each type of information that Outlook manages is stored in a separate Outlook folder. A particular piece of information
stored in an Outlook folder is known as an item, for example, an e-mail message stored in Inbox folder, an appointment
stored in Calendar folder etc. As explained later on in the manual, you can also create one or more additional folders to
store each information type. The table Below lists the function and the type of information stored in each of the default
Outlook folders that Outlook initially sets up.
Default Outlook Folder

Description

Outlook Today

Enables the user to keep track of your appointments and tasks in one
window along with keeping you informed of the e-mail you have.

Inbox

Receives your incoming messages, enabling the user to send and receive
messages.

Calendar

Enables the user to schedule appointments and events.

Contacts

Enables the user to enter and keep track of business and personal
contacts.

Tasks

Enables the user to create and manage tasks.

Journal

Records all items as they occur, such as accessing an office file, sending an
e-mail message

Notes

Electronic “sticky notes”, storing text information that enables the user to
quickly record reminders.

Deleted items

Contains any items that the user deletes in Outlook before they are
permanently deleted.

Sent Items

Keeps copies of messages that have been sent by the user.

Outbox

Temporarily contains message that the user sends until they are delivered.

Drafts

Stores incomplete messages enabling the user to go back to them to
complete and send later on.

View Area
To view and work with the items of information stored in a particular folder, you need to open that folder. Outlook will
then display the folder’s items in the View pane of the Outlook window and the Outlook ribbon command buttons will
change to provide the commands you need to manage the type of information kept in that folder.

Navigation Pane
The Navigation Pane on the left allows you to access the other data stores or folders in Outlook, such as the calendar, tasks
etc. You can drag a folder such as inbox to the favourites section of the navigation pane if you have many mail folders
this will enable quick access to your inbox no matter which folder you happen to be in.
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➢➢ To Access A Different Folder Type
mouse
1. Click on the folder type you wish to access such as calendar you will then notice your calendar appear in the
main view pane.
2. If you have more than one calendar in your mailbox select the calendar you wish to view in the navigation
pane for it to appear in the main view area.

Outlook Shortcuts
One of the fastest ways to open an Outlook folder is to use Shortcuts. Users can add shortcut groups that quickly open
their favourite and most frequently used folders. The user can add, remove or change the size of the shortcuts. The
Shortcuts section in the Navigation pane can be divided into groups to help organise the user’s information. These groups
contain related shortcuts. Users can also create their own groups.
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➢➢ To Switch To Shortcuts:
Mouse
1. Click the Shortcuts icon at the bottom of the Navigation Pane The Shortcuts may be one of the
minimised icons.
2. The navigation pane will display hyperlinks allowing you to set up a shortcut to a particular item, file,
or web page.
Keyboard
3. Press [CTRL] 7
➢➢ To Create An Item That Includes A Shortcut To Another Outlook Item:
Mouse
1. Use the right mouse button to click on the item that you want to create a shortcut for, and drag it to the
folder where you want to create the new item.
2. Release the mouse button, and, from the pop-up menu that appears, choose Copy Here as <type of
new item> with Shortcut.
➢➢ To Create A Hyerlink To A Website In Your Shortcuts
mouse
1. Open up the web page you wish to create a shortcut to.
2. Go to shortcuts in the navigation pane.
3. Arrange windows so you can drag the icon next to the web address in internet explorer to the shortcuts in
outlook.
4. Simply drag and drop as described ensuring you selected the icon to the web address.
5. The web should be either on the internet/ intranet or a file you are capable of accessing from other machines
if on the network.
•

If the Navigation pane is not displayed, choose the View, NavigationPane command from the Ribbon.
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➢➢ To Remove A Shortcut:
Mouse

6. Right-click on the shortcut and choose Delete shortcut from the menu
➢➢ To Reorder A Shortcut:
Mouse
1. Click and drag the shortcut required to a new location in the Navigation Pane.
2. Release the mouse.
Or
1. Right click on the shortcut and choose move up or move down.
2. Repeat as needed

Previewing Items
You can view the contents of an Outlook item without having to open it in a form.

Autopreview

AutoPreview allows you to see the first few lines of a message in the main Outlook view window.
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➢➢ To Use Autopreview
Mouse

On the Viewtab, click Change Viewthen the Preview icon from the displayed choices.
To hide the AutoPreview, On the Viewtabclick reset view.
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Reading Pane

When in a mail folder a reading pane can be turned on (On by Default) or off to allow you to see the contents of an
email just by selecting it in the view area. Using your down cursor key you can quickly “view” your emails and move on
to the next without having to constantly reach for your mouse. You may turn the reading pane on or off (or have it at the
bottom of the screen instead of the right)
You can set options to determine how messages are treated when viewed in the Reading Pane – for example, do you want
them to appear as read or stay unread.
➢➢ To Turn Reading Pane On Or Off
mouse
1. Go to the view tab and click on the reading pane button in the Layout group
2. From the displayed choices make a selection and the reading pane will be adjusted
•

The reading pane is on by default for any folder you create to store emails and will have to be turned off
manually for each folder.

To Position The Reading Pane
Mouse

1. Choose the View tab, layout group,Reading Pane button.
2. Choose the Right or Bottom from the sub-menu.
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➢➢ To Set Reading Pane Options
Mouse
1. Choose the View tab, layout group,Reading Panebutton.
2. Set the options you require and click OK.

Microsoft Outlook Help

Outlook 2010 offers several ways to get help when performing particular tasks. You can select from a list of topics provided
by Help, or you can even type a help request in plain English, and Outlook help will point you to the right location. Most
of the help is found in one location.
Outlook 2010 provides a new alternative to using the old assistant,. You can get help by typing a question or phrase in to
the Help search Box that you will find by clicking the question mark in the upper-right corner of the application.

Download free eBooks at bookboon.com

25

Outlook 2010: Part I

Understanding Outlook 2010

➢➢ To Access Help
mouse

1. Open the help window by clicking on question mark in top right hand corner of the application.
2. Type a question or phrase and click the Search button.
3. Scroll through the topics, if necessary, or by clicking on the hyperlink to the desired topic The help text will
be displayed in the Help Window.

.
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Section 3 Using Folders
Objectives
By the end of this section you will be able to:
•

Understand The Use Of Folders.

•

Create And Manage Your Folder List.

•

Navigate Within The Navigation Pane.

•

Create And Use Favourite Folders.

•

Create And Use Public Folders
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What is a Folder
A Folder is a container that holds items within Outlook if you are working with emails then the folders you will use will be
email folders. If you are in a calendar you are in a calendar folder which holds items like appointments and meetings.each
diiferent kind of folder holds a different kind of item and you cannot store appointments in an email folder and vice versa.
For the most part of this section we will concern ourselves with email folders. ALL folders are contained within your
mailbox but within outlook they are filtered when you are in the various sections of Outlook. For instance if you click on
the mail section in the navigation pane you will only see folders that can contain email items. If you click on the calendar
section. The various calendars you may see ONLY contain calendar items.

The Folder Ribbon

In earlier versions of Outlook there were folder commands in many different locations but now they have been all brought
together in one location on the folder ribbon. Any work we do with folders will be from this tab.
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Creating Folders

Users have the ability to create their own folders for organising and storing information. Subfolders can also be created
for additional levels of organisation. Subfolders can be copied and moved within the tree structure.
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➢➢ To Create A New Folder:
Menu
1. Go to the Folder tab on the ribbon and to the New group, click on New Folder.
2. In the Name box, type the name for the new folder.
3. In the Folder contains box, select the type of items the folder is to contain, e.g. Mail Items (this will
be the default.)
4. In the Select where to place the Folder box, choose the location for the folder, e.g. lnbox and
click OK.
OR
Mouse
1. Click the right mouse button on the Folder list, choose New Folder.
2. Continue as Previous.

Renaming A Folder
➢➢ To Rename A Folder:
Menu
1. Select the folder to rename.
2. Go to the Folder tab on the ribbon and to the Actions group, click on Rename Folder.
3. Enter new name and press return
Or
1. Click the right mouse button on the folder to rename, choose Rename Folder.
2. Type new folder name and press [ENTER].

Expanding And Collapsing A Folder
If the user has lots of subfolders, the Folders list can become long and lots of scrolling may be needed to find a particular
folder. The user can collapse and expand the Folders list and view just the folders required. Expandable folders are
indicated by a + symbol displayed next to them. Collapsible folders have a - symbol displayed next to them.
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➢➢ To Expand A Folder:
Mouse

1. Click on the little triangular arrow next to a folder to expand the branch
Or
1. Double-click on the folder to expand.
➢➢ To Collapse A Folder:
Mouse
1. Click on the little triangular arrow next to a folder to collapse the branch
Or
1. Double-click on the folder to collapse.

Moving And Copying Folders
Folders can be moved or copied within the tree structure.

Download free eBooks at bookboon.com

31

Outlook 2010: Part I

Using Folders

➢➢ To Move A Folder:
Menu
1. Select the folder to move
2. Go to the Folder tab on the ribbon and to the Actions group, click on Move Folder.
Or
1. Drag the folder you wish to move and drop it in the folder you wish to move it to.
Or
2. Click the right mouse button on the folder you wish to move, choose Move
3. In the Move folder box, choose the new location for the folder, e.g. lnbox.
4. Click ok. The folder moves to become a subfolder of the folder selected in step.
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➢➢ To Copy A Folder:
Mouse
1. Select the folder to copy.
2. Go to the Folder tab on the ribbon and to the Actions group, click on Copy Folder.
Or
1. Click the right mouse button on the folder to move, choose Copy.
2. In the Copy folder box, choose the location where the folder is to copy to, e.g. lnbox.Choose OK.
or
1. Press [CTRL] + click and drag the folder required to the new location, e.g. lnbox.

Deleting Folders
Folders and subfolders can be deleted from the Folder list. When deleting a subfolder, the contents of the folder are also
deleted. Folders are moved to the Deleted Items folder so if a mistake is made this is where to retrieve them.
➢➢ To Delete A Folder:
Menu
1. Select the folder to copy.
2. Go to the Folder tab on the ribbon and to the Actions group, click on Copy Folder.
Or
3. Click the right mouse button on the folder to be deleted, choose Delete
•

Deleted folders can be retrieved simply by clicking and dragging the folder required from Deleted Items folder to
another folder.

Favourite Folders
The favourites folders are merely shortcuts to your most often used folders. If like many people you have many folders
holding messages from different workmates or assigned a folder based on their content such as a particular project, you
may only use 4 or 5 folders on a regular basis and instead of searching all the way through your folder list to find them
you can assign them to the favourites section for easy access.
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➢➢ To Aasign A Folder As A Favourite
mouse

1. Select the folder to assign as a favourite.
2. Go to the Folder tab on the ribbon and to the favourites group, click on show in favourites
button.
3. The button will become highlighted and the folder will appear in the top left of the navigation pane in the
favourites section.
•

Remember this is only a shortcut and can be removed without removing the actual folder from your mailbox

➢➢ To Remove A Favourite
mouse
1. Select the favourite to be removed then go to the Folder tab on the ribbon and to the favourites
group, click on show in favourites.button
The favourite will disappear.
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Public Folders
Public folders are an easy and effective way to collect, organise, and share information with others on your team or across
your organisation. You can use public folders to store any type of file or Outlook item.
Use public folders to:
•

Post information on an electronic bulletin board. People who use the bulletin board can participate in online
discussions. For example, a workgroup can review and provide feedback on new product ideas.

•

Share Outlook items in a schedule, contact list, or task list. People can review information that is constantly
updated. For example, you might use a company calendar folder to publicise company meetings and holidays, a
group contacts folder to make information about the people who work on a project available to everyone, and a
team tasks folder to help everyone keep track of work on a project.

•

Share files. People have fast access to files created in other programs, such as Microsoft Excel or Word. For
example, you might use an employee information folder to find information about company policies or a
product reference folder to get product information out to everyone who needs it.

Public folders are created and designed by administrators and others in your workgroup or organisation who have the
appropriate permission. If you have permission, you can set up your own public folders and give other people permission
to use them. If you want to be innovative, you can apply your own custom views, forms, custom fields, and rules to your
public folders.
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Creating A Public Folder

To create a public folder, you must have permission to create folders in an existing public folder. For information about
how to obtain permission, see your administrator. Apart from this it is much the same as creating any other folder.
➢➢ To Create A Public Folder:
Menu
1. Go to the Folder tab on the ribbon and to the New group, click on New Folder.
2. In the Name box, type the name for the new folder.
3. In the Folder contains box, select the type of items the folder is to contain, e.g. Mail and post Items
(this will be the default.)
4. In the Select where to place the Folder box, choose the location for the folder within the
public folder lists and click OK.
You can copy a private folder to a public folder to quickly start a public folder with existing items.

Using Public Folders
You will find all public folders in Outlook positioned under your own private mailbox.
YOU must be in Folder list view!!! to see public folders
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➢➢ To Open A Public Folder:
Mouse

1. In the Folder List in the navigation Pane, click Public Folders, and then click the folder you want to
open.
2. If the folder you want to open is located within another folder, small triangular arrow next to each subfolder
to expand them until you find the folder you want.
➢➢ Add A Public Folder Shortcut To Favorites
Mouse

1. In the Folder List, right-click the public folder for which you want to add a shortcut, and then click Add
to Favorites on the shortcut menu.
2. To change the name of the public folder that appears in your Favorites folder, type a new name in the
Favorite folder name box.
3. To add shortcuts to subfolders of this public folder, click Options, and then select the options you want.
4. Click Add.
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➢➢ To Post Information In A Public Folder:
Mouse
1. Open the public folder you want to post information in.
2. To use the default form for posting information, go to the home ribbon, go to the New group, and then
click New post.
3. In the form, enter the information you want to post.
4. Click Post.
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➢➢ Reply To Information Posted In A Public Folder:
Mouse

1. Open the public folder that contains posted information you want to reply to.
2. Open the item or file you want to post a reply to.
3. To use the default form to reply to posted information, on the discussion tab, in the respond group,
click Post Reply.
4. In the form, enter the information you want to post. Click Post.
➢➢ Reply To The Person Who Posted Information In A Public Folder:
Mouse
1. In the Folder List, in the navigation pane click Public Folders, and then click the folder you want to open.
2. If the folder you want to open is located within another folder, click on the small triangular arrow next to
each subfolder to expand them until you find the folder you want.
3. Select the item or file you want to reply to.
4. Click Reply on the discussion tab in the respond group.
5. Type your reply and click Send.

Setting Permission Levels
You must have Owner permission: With Owner permission you can create, read, modify, and delete all items and files and
create subfolders. As folder owner, you can change the permission level that others have for the folder. This permission does
not apply to delegates.) permission for a public folder to set sharing permissions for the folder. You can set permissions
for only one folder at a time.
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➢➢ To Set Permission Levels:
Mouse

1. In the Folder List, right-click the public folder you want to share, and then click Properties on the
shortcut menu.
2. Click the Permissions tab.
3. Click Add.
4. In the Type name or select from list box, enter the name of the person you want to grant sharing
permissions to.
5. Click Add, and then click OK.
6. In the Name box, click the name of the person you just added.
7. Under Permissions, choose the settings you wish to assign this person and click OK.
•

You can assign everyone who has access to the folder the same permissions by clicking Default in the Name box.
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Section 4 Mail Messages
Objectives:
By the end of this section you will be able to:
•

Understand Mail Terminology

•

Compose, Address And Send Mail Messages

•

Receive And Read Messages

•

Reply And Forward Messages

•

Insert Data Into A Message

•

Save Attachments

Brain power

By 2020, wind could provide one-tenth of our planet’s
electricity needs. Already today, SKF’s innovative knowhow is crucial to running a large proportion of the
world’s wind turbines.
Up to 25 % of the generating costs relate to maintenance. These can be reduced dramatically thanks to our
systems for on-line condition monitoring and automatic
lubrication. We help make it more economical to create
cleaner, cheaper energy out of thin air.
By sharing our experience, expertise, and creativity,
industries can boost performance beyond expectations.
Therefore we need the best employees who can
meet this challenge!

The Power of Knowledge Engineering

Plug into The Power of Knowledge Engineering.
Visit us at www.skf.com/knowledge
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Using Mail Messages
In order to utilise the electronic mail feature available in Outlook 2010, the user
must be familiar with the terminology used to describe its various aspect
Terminology

Description

The Global Address List

The address book that contains all user, group, and distribution list e-mail
addresses in your organisation. The administrator creates and maintains this
address book. The Global Address List may also contain public folder e-mail
addresses.

Outlook Address Book

The Outlook Address Book is automatically created from contacts in the
Contacts folder. The contacts can be people inside and outside of your
organization. When you update your contacts, the Outlook Address Book is
updated as well.

Contacts

This is a customisable address book best used to store personal distribution
lists you frequently address messages to, such as a list of everyone on the
racquetball team. Personal Address Book files have a .pab extension and can
be copied to a disk.

Distribution List

A collection of user names, identified by one unique name that is used for
addressing messages to group users.

Creating Mail Messages
Outlook allows the user to compose new mail messages, send messages, receive messages and read incoming mail messages.
The messages are the basic unit of communication within Outlook. A message can contain multiple items, one of which
is the actual message. When composing a message, Outlook displays the Message form with an Options icon on the
ribbon. The Message form is used to add message recipients, a message subject and the body of the message. The Options
are used to set general, delivery and tracking options for the mail message.
Messages can be addressed to other Mail Recipients either via the Global Address List, which lists the names of the other
users on an exchange network, or if the mailbox name of the recipient is known, it can be typed into the Message form.
Using the Global Address List ensures that the recipient is a valid Mail Address and that the recipient’s name is correctly
entered. The Global Address List is created and maintained by the Mail Administrator.
Mail recipients outside the organisation would not be found in the global address list and would therefore be stored in
your contacts folder within outlook, this is your Personal address book. (Outlook address book) People entered here
would have to have a valid email address such as bob.smith@msn.com this type of address is an internet mail address
for external communication.
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➢➢ To Create A Message:
Mouse

1. While in any mail Folder choose Newemail from theNew group on the home ribbon.
Or
Mouse
2. While in any Folder choose New Item from theNew group on the home ribbon.
3. Select new email
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4. The Message screen consists of the message ribbon and the following sections.
Section

Description

To:

Displays the main recipient(s) of the message.

Cc:

Sends a “carbon copy” of the message to the recipient(s), and the recipient’s
name(s) is visible to other recipients of the message.

Subject

A subject can be entered or left blank in this section. Text typed in this section
is displayed in the recipient’s Inbox View Pane conveying the contents and
urgency of the message.

Message area

Contains the message and attachments being sent.

People Pane

The people pane is new to 2010 and shows the social connections between
you and the recipients when connected to a social network site such as
Facebook or MySpace, by default it is minimised.

Ribbon

The various tabs allowing formatting, insertion, and email options and access
to backstage view for printing, saving and further options.
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Addressing Messages
Messages can be sent to individual or multiple recipients. If the user knows the names of the recipients, they can be typed
in the To box with each recipient name separated from the next by a semicolon, otherwise the user can select recipients
from the Global Address List. The subject text typed is important, as this is displayed in the recipient’s Inbox. Once the
message has been addressed and the subject text typed, the user is then ready to type the message they require. The [TAB]
key is used to move from one area to the next.
➢➢ To Select Names:
Mouse

1. In the To box,
2. Click the TO…button to select Names from the address books.

3. Choose from the drop down list under address book which address book you wish to use.
4. In the List box, select the required recipient name and either double click on it or click the To -> button to
add the name to the recipient list. The [ctrl] key can be used to select multiple names from the list. The
selected recipient name(s) will display in the To -> Message Recipients box.
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5. Repeat step 2 to add further recipients and change the address book displayed at the top right corner of the
select names dialog box if you need to select names from a different address book.
6. Select the name(s) of the recipient(s) who are to receive a copy of the message and click the CC -> or Bcc
- > to add the selected names to the Cc and Bcc Message Recipients box. (The Bcc recipients will be hidden
from the rest of the recipients listed when they receive the email).
7. Click OK to return to the message form all the selected names will be displayed in the corresponding
address fields.
Or
1. You can type the names of the recipients in the address fields, as you type, Outlook will constantly search
your address books for a match and as soon as a match is found, the full name will be displayed. To accept
the name displayed, press [ENTER], otherwise continue to type and press [ENTER] to separate the names
with a semi colon.
2. Press [TAB] to move to Subject.
3. Type the message subject.
4. Press [TAB] to move to the Message area.
5. In the Message area, type the required message
Before you send a message, Microsoft Outlook automatically checks the names you type in the To, Cc, and Bcc boxes
against the names in the Address Book and against those contact folders that you’ve specified as Outlook Address Books.
If an exact match is found, the name is underlined. If multiple matches are found, a window will open allowing you to
choose the person you wish to send to.

If multiple matches are found, and you have used the address before, the name you chose previously is displayed in the
box with a green, dashed underline to remind you that there are other matches. Right-click the name to see the matches.
You can also manually check names in messages by clicking the Check Names button on the message toolbar.

Editing Message Text
Messages can be edited using the standard Windows editing techniques. Placing the insertion point at the relevant
position in the message and typing the new text can insert text. Any text to the right of the insertion point is pushed
along. Selecting it and simply typing the new text can replace text. Text can be repositioned within the message by using
the Cut, Copy and Paste procedures.
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➢➢ To Select Text:
Mouse
1. In the Message form, click and drag over the text to be selected.
➢➢ To Deselect Text:
Mouse
Click away from the selected text.
➢➢ To Delete Text:
Keyboard
1. Press [BACKSPACE] to delete any characters to the left of the insertion point.
Or
2. Press [DELETE] to delete any characters to the right of the insertion point.
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➢➢ To Cut, Copy And Paste Text:
Menu
1. Select the text to be cut or copied.
2. Choose Cut from the clipboard group on the message ribbon
Or
1. Choose copy from the clipboard group on the message ribbon.
2. Position the insertion point where the text is to be inserted.
3. Choose Paste from the clipboard group on the message ribbon.
Mouse

1. Select the text to be cut or copied.
2. To cut the selected text, click.

Or
3. To copy the selected text click.

4. Position the insertion point where the text is to be inserted.
5. Click to paste the text.

Formatting Text
A message can be enhanced by applying formats and changing its alignment. These changes can be made in two ways,
via the Format menu or using the formatting toolbar. The Formatting toolbar is used to apply the most commonly used
formats.
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➢➢ To Format Text:
Menu

1. In the Message form, select the text to format.
2. Choose formatting options from the basic text group on the message ribbon.
Or
1. Click the right mouse button on the selected text and choose from the mini toolbar

or
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2. To access extra text formatting options.Click on the dialog box launcher to the bottom right of
the basic text group on the message ribbon
3. The Font dialog box displays.
4. Make the font selections you desire
5. Click OK
or
If more advanced formatting of text is required such as you would wish to do in microsoft word then you will have to go
to the format text ribbon where all formatting options as exhibied in microsoft word is available to you
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➢➢ To Access Advanced Text Formatting
mouse
1. Click on the format text ribbon at the top of the message all of microsoft word text formatting options
are available to you. (see microsoft word)
Font Options

Description

Font

Displays the fonts available for the current printer. Font refers to the design of the
typeface.

Font Style

Displays the styles available for the selected font.

Size

Displays the available sizes of the selected font. The larger the size, the bigger the
text.

Font Color

Displays a variety of colours that can be applied to the selected text.

Underline style and
Underline colour

Underlines all characters, including spaces between words with a single line style
with the option of selected a colour underline.

Effects

Displays a combination of effects to be applied to the selected font.

Paragraph Alignment
Paragraph alignment aligns selected text relative to the left and right margins. If no text is selected, the paragraph
containing the insertion point (flashing cursor) is aligned.
➢➢ To Align Text:
Menu
1. In the Message form, select the text required.
2. From the basic text group choose the alignment of text you would like
Or
1. Click on the format text ribbon at the top of the message.
2. Go to the paragraph group
3. Use the dialog box launcher to access further paragraph alignments and options

Download free eBooks at bookboon.com

51

Outlook 2010: Part I

Mail Messages

Option

Description

Left

Aligns text to the left margin.

Centre

Centres text between the left and right margins.

Right

Aligns text to the right margin.

Justify

Aligns text equally between the left and right margins.

Bullet

Inserts a bullet at the left margin preceding each selected paragraph. The first
line of text following a bullet is automatically indented to the first tab position.

4. Choose the required alignment.
5. Choose OK.
or
1. Select the text required.
2. Click the required alignment button from the paragraph group on the format text ribbon

Spelling And Grammar Checker
Outlook has the facility to check the spelling of any item including mail messages. When the Spell Checker is started,
any incorrect spellings are highlighted and alternative suggestions displayed. The Spelling option can be set to check all
messages automatically before they are sent.
➢➢ To Spell Check A Mail Message:
Menu
3. In the Message form, choose Review ribbon, then Spelling and Grammar. The Spelling dialog box displays,
highlighting the first incorrect word.
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4. Choose the required options.
Option

Description

Not in Dictionary

Displays the first incorrect word.

Suggestions

Lists proposed words from the dictionary.

Ignore Once

Leaves the highlighted error unchanged throughout the message.

Ignore All

Leaves all instances of the highlighted error unchanged throughout the
document and continues to check the document. Word will ignore this spelling
error or type of grammar error throughout the rest of the current Word session.

Add to Dictionary

Adds the highlighted word to the dictionary.

Change

Changes the word to the selected word shown in the “Change to” box. When
the selected error is a duplicate word, the Change button is replace with a
Delete button.

Change All

Changes all instances of the highlighted word to the selected word in the
“Change to” box.

Auto correct

Adds the spelling error and its correction to the AutoCorrect list so that Word
will correct it automatically as you type.

Options

Opens the Spelling & Grammar Options dialog box, where you
can open a different custom dictionary or change the rules that
Word uses to check spelling and grammar.

Undo

Reverses the last spelling change.

Check grammar

Clear this check box if you don’t want Word to check the grammar in the active document.

Or
Keyboard
1. Press [F7]then choose the required options.
2. The Spelling dialog box automatically closes on completion and a dialog box displays, confirming that the
spell check is complete.
➢➢ To Set Spelling Options:
Menu
1. In Backstage view (File tab), choose Options.
2. The Options dialog box displays.Choose the Mail button on the left.

Download free eBooks at bookboon.com

54

Outlook 2010: Part I

Mail Messages

3. Check or uncheck the ‘always check spelling before sending’ option.
4. Click the spelling and autocorrect… button
5. Set the required options and click OK.

Sending Messages
Once the user has composed a mail message, the message can then be sent to the relevant recipients.
➢➢ To Send A Message:
Menu
1. Compose the message.
2. From the message in front of the to, cc buttons click the send button.
3. The message is sent to the recipients.
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➢➢ To View Sent Messages:
Mouse
1. In the Navigation Pane, select the Sent Items folder.
2. A list of messages sent will display in the View Pane.

Saving Unsent Messages
Messages can be composed and saved to the Draft folder. When the message is ready to be sent, it can be opened from
draft, edited and sent.

CHALLENGING PERSPECTIVES

Internship opportunities
EADS unites a leading aircraft manufacturer, the world’s largest
helicopter supplier, a global leader in space programmes and a
worldwide leader in global security solutions and systems to form
Europe’s largest defence and aerospace group. More than
140,000 people work at Airbus, Astrium, Cassidian and Eurocopter,
in 90 locations globally, to deliver some of the industry’s most
exciting projects.
An EADS internship offers the chance to use your theoretical
knowledge and apply it first-hand to real situations and assignments
during your studies. Given a high level of responsibility, plenty of

learning and development opportunities, and all the support you need,
you will tackle interesting challenges on state-of-the-art products.
We welcome more than 5,000 interns every year across
disciplines ranging from engineering, IT, procurement and
finance, to strategy, customer support, marketing and sales.
Positions are available in France, Germany, Spain and the UK.
To find out more and apply, visit www.jobs.eads.com. You can also
find out more on our EADS Careers Facebook page.
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➢➢ To Save Message As A Draft:
Mouse
1. Compose the message.
2. In the Message form, Click the close button or press Esc to close the window and choose Yes to save
changes to the item.
3. The saved message displays in the Draft folder with a

symbol attached to it.

or
1. Compose the message.
2. In the Message form, choose the File tab and close. Choose Yes to save changes to the item.

➢➢ To Open Unsent Messages:
Mouse

1. In the Draft folder, double-click on the message to open.
2. Make any amendments to the message.
3. To send the message, click send
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Cancelling Messages
If the user chooses not to send a composed message, it is easily cancelled.
➢➢ To Cancel A Message:
Mouse
4. Compose the message.
5. In the Message form, Click the close button or press Esc to close the window
6. Choose No to save the changes to the item. The Message form automatically closes without sending or
saving the message.

Dealing with Mail Messages
All incoming mail messages are automatically stored in the user’s Inbox folder, making it easier for the user to find incoming
mail. When the contents of the Inbox folder is displayed in the View Pane, column headings display informing the user
of any messages that have been received. The column headings display the sender, subject details and the date and time
the message was received. By default, Outlook automatically applies the Messages with AutoPreview to the Inbox. This
view allows the user to see the first three lines of a message without having to physically open it.
You can get Outlook to notify you in different ways when new messages arrive
➢➢ To Notify When New Messages Arrive
Mouse
1. Choose the File Tab and click Options.
2. Click the mail button on the left.
3. Scroll down to the message arriving section

4. Make a selection from the options on how you wish outlook to react when a new message arrives
5. Click ok to apply choices
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Unread Messages
Any unread messages are displayed in bold in the View Pane. When a message is opened, it is displayed in the Message
form allowing the user to view the previous or next message in the listing without going back to the Inbox.
➢➢ To Open A Mail Message:
1. In the Navigation Pane, choose Inbox.
2. All messages received are displayed in the middle of the window in the View Pane.

If the reading pane is turned on the body of the message should appear to the right of the view pane.
Messages are automatically grouped under day and week headings to make it easier to find them. You can click
the arrow signs next to the labels to expand and collapse the groups to show and hide the messages in them.
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➢➢ To Read The Message
Mouse
1. Double Click on the message.

2. The Message form opens, displaying the selected message.
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Moving Between Messages
In the Message form, it is possible to view any previous messages or messages that follow the current message without
having to return to the View Pane.
To View The Previous Message:
Mouse
In the Message form, click

. The previous message from the Quick access toolbar.

To View The Next Message:
Mouse
In the Message form, click The

previous message from the Quick access toolbar.

To Close The Message Form:
Menu
1. Choose File from the tabs, then click Close.
Or
Mouse
1. Click the close button or Use the Esc key on the keyboard.

Replying To And Forwarding Messages
Once a message has been read, the user can, if required, reply to just the message sender or reply to the message sender
and all recipients of the original message. When replying to a message using the Reply to Sender or the Reply to All
option, the reply message is automatically addressed to the originator of the message. The Reply form also displays the
original message and the subject details of the message with the prefix RE:. The reply to the message can be typed above,
below or in the body of the original message. Reply text is in blue by default.
We can use the respond group on the home ribbon to respond to unopened messages or if the message is open then the
same respond group is available on the message tab.
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➢➢ To Reply To A Message:
Mouse

1. In the lnbox folder, select the message to reply to.
2. To reply to the sender, click reply
Or
1. To Reply to All, click reply to all.
2. The RE: message form displays. Type a reply message.
3. Click Send

or
1. In the lnbox folder, select the message to reply to.
2. Click the right mouse button on the selected message, choose Reply or Reply to All.
3. The RE: message form displays. Type the reply message.
4. Choose File, Send.
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Forwarding Messages
Once a mail message has been read it can be forwarded to other Mail Users. The sender’s own comments can be added
to the message before it is sent to other members. As with replying to messages, the subject of the original message is
automatically entered in the Subject box with a prefix. in this case FW: indicating that the message is a forwarded message.
When forwarding a message the original message with the address information is automatically entered in the Message area.
➢➢ To Forward A Message:
Mouse

In the lnbox folder, select the required message.
1. Click the forward button in the respond group The FW: message form displays.
2. Click the to.. button. The Select Names dialog box displays.

3. Select the names of the recipients to receive the forwarded message.
4. If required, type a message in the Message area.Click send
or
1. Click the right mouse button on the selected message, choose Forward.
2. The Fw: message form displays. Follow steps iii to v as mouse method.

Inserting Data into a Message
Information can be inserted or copied into other messages. Objects and files from other Windows applications be inserted
into messages.

Download free eBooks at bookboon.com

64

Outlook 2010: Part I

Mail Messages

➢➢ To Copy Information Between Messages
Menu

1. Open the required message to copy information from.
2. In the Message area, select the text to be copied.
3. Choose Copy from the clipboard group on the message tab
Or
1. Click the right mouse button over the selected text and choose Copy from the Mini-Toolbar.
2. The copied item is stored in memory.
3. Closethe message.
4. Open the message to Paste the information into
Or
1. Compose a new message.
2. Position the insertion point in the Message area.
3. Choose paste from the clipboard group on the message tab
Or
4. Click the right mouse button at the desired insertion point and choose paste from the Mini-Toolbar.
The desired text is pasted into the message.
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➢➢ To Copy Information From A File:
Menu

1. Open the required Microsoft application and document.
2. Select the required information to be copied.
3. Choose Copy from the clipboard group on the Home tab
4. Close the document and application.
5. In Outlook, compose a message or open an existing message.
6. Position the insertion point in the Message area.
7. Choose Paste from the clipboard group on the message tab
Or
8. Click the right mouse button at the desired insertion point and choose paste from the Mini-Toolbar.
9. The copied information is inserted at the insertion point.

Attaching Files And Objects To A Message
One or more files or objects can be attached to a message.

➢➢ To Attach A File Or Object To A Message:
Menu
1. Compose a new message or open an existing message.
2. In the Message area, Attach File from the include group on the message tab.
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3. Navigate to the location of the file you wish to attach.
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4. Select the folder and filename required.
5. Click on the Insert drop down arrow to select the method you want to insert the file.

6. The attached file displays in the Message header under Attached
or

1. Compose a new message or open an existing message.
2. Go to the Insert ribbon Include group and click on attach file
3. Follow steps iii to vi as menu method.

Attaching Items
An Item is an object within outlook itself such as amessage a calendar appointment a task or note.
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➢➢ To Insert An Outlook Item In Message:
Mouse

1. Click the down arrow next to the attach item buttonin the include group on the message.
2. Make a selection of what type of item you wish to insert.
3. Choose outlook Item.
4. The Insert Item dialog will be displayed
5. Select the item you wish to insert and click OK. The item will be inserted as an attachment or text
depending on which Insert As option you selected.
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Opening Attached Files:
When a message with an attachment is received, the attachment is represented in the Inbox by a paper clip. Attached
files can be opened from a message as long as the corresponding application is available.
➢➢ To Open An Attachment:
Mouse
1. Open the message containing the attachment.
2. In the Message area, double-click on the object/file icon. The application the attachment belongs to opens
and loads the file.
3. When finished, exit the application in the normal way.
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Saving An Attachment
If the user wishes to keep an attached file, it can be saved to a folder or to a floppy disk.
➢➢ To Save An Attachment:
Mouse
1. Open the message containing the attachment.
2. In the Message Header area, double-click on the Application icon. The application the attachment belongs
to opens and loads the file.

3. Choose File from the ribbon, then Save As.
4. Select the drive and folder to save the file to.
5. If required, type a new filename.
6. Choose Save.
7. On completion, exit the application in the usual way.
Or
1. Right click the attachment icon in the message header and choose Save as...
2. Select the drive and folder to save the file to.
3. If required, type a new filename.
4. Choose Save.
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Section 5 Message Options
Objectives:
By The End Of This Section You Will Be Able To:
•

Set Importance And Sensitivity

•

Ask For A Read And Delivery Receipts

•

Ask Others To Vote

•

Divert Replies

•

Set Delivery And Expiry Dates

•

Flag Messages For Follow Up

•

Create An Autosignature

•

Use More Than One E-Mail Account
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When composing a message, the user can set various message options before a message is sent.
➢➢ To Set Message Options:
Mouse
1. Choose New Message and Click the options tab.
2. The regular options above are displayed.
3. For further options click on a dialog box launcher in one of the groups.
4. A dialog will open with more choices for options
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Importance
Contains three levels of message importance or priority: high, normal and low. Setting message priorities affects how
the message is routed from source to destination. High priority messages are routed to their destinations before normal
messages, and low priority messages are transmitted last. The default setting in Outlook is normal. A symbol displays
in the recipient’s View Pane indicating the message importance. High displays a red exclamation mark in the recipient’s
Inbox, Low displays a down arrow in the recipient’s Inbox. Normal messages have no symbol against them.
➢➢ Change The Importance Level
Mouse
5. Click the importance drop-down arrow and select High or Low click for very important or not important.

Sensitivity
You can mark your messages as Personal, Private or Confidential and the banner in message header will display the
selected option.
➢➢ Define The Sensitivity
Mouse
1. Click the sensitivity drop-down arrow and select Personal, Private or Confidential.
•

Marking a message Private prevents the message from being modified after you send it.

Voting Buttons
You can send out mail messages that need recipients to respond in a preset way. Microsoft Outlook calls this “voting”.
When you set voting options in a message, Outlook creates buttons relating to the options that you specify for the recipients
to click. You can then track the results by viewing the votes.
➢➢ To Set Voting Options:
Mouse
1. Select the Use voting buttons check box, and then click the voting button names you want to use in
the box.
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To create your own voting button names, delete the default button names, and then type any text you want.
Separate the text with semicolons. For example: Small; Large; Extra Large.

2. Close and de-select the Save sent messageto check box, and then enter the folder name
where you want the message saved and Close.
3. Click Send.

View Vote Responses To A Message
To review the results of the voting, you use Outlook’s tracking.
➢➢ To Track Voting Responses:
Mouse
4. Open the original message with the vote in it. This is usually in the Sent Items folder.

5. In the message header.click on the information bar where it states the current results of you voting
and select from the option that appears view voting responses.
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➢➢ To Copy The Results Of Voting Responses:
Mouse
1. View the voting responses.
2. Select the responses you want to copy. To select all rows, click the first row, and then hold down [SHIFT]
and click the last row.
Or
3. To select nonadjacent rows, click the first row, and then hold down [CTRL] and click additional rows.
4. On the clipboard group, click Copy.
5. Switch to the other program or to the text box of the item you want to copy the information to.
6. On the Clipboard group, click Paste.

Read And Delivery Receipts
Outlook can notify when messages are delivered or read by returning a message to you verifying the date and time the
message arrived at the mailbox of the recipient “ Delivery Receipt” or verifying the date and time the message was opened
by the recipient “return Receipt”.
➢➢ To Be Notified About A Message
Mouse
1. Beneath the Voting and tracking options, select the Request a delivery receipt for this message or the
Request a read receipt for this message check box.
or
1. On the options ribbon in the tracking group make the choice there to have a read or delivery reciept
by ticking the respective box.

Have Replies Sent To
Outlook can send replies to a particular message to someone else, such as an assistant.
➢➢ To Have Replies Sent To Some Body Else
Mouse
1. Check the Have replies sent to box and type the name of the person you want to receive the reply
messages in the space provided or click Select Names button to select the name from an address book.
or
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1. On the options ribbon in the more options group click on the button direct replies to
button enter or select the name you wish to enter from the properties dialog
2. Click ok to close and accept your selection

Do Not Deliver Before
When used, this option keeps the message in the sender’s Outbox folder until the date and time specified.
➢➢ To Not To Deliver A Message Before A Specific Date
Mouse
1. Check the Do not deliver before box and specify the date and the time when you want the message to be
delivered.
Or
2. On the options ribbon in the more options group click on the button direct replies to
button enter or select the name you wish to enter from the properties dialog.
3. Click ok to close and accept your selection
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Expiry Date
This option makes the message unavailable by deleting the message after the specified date and time provided the
recipient(s) has not read it.
➢➢ To Set An Expiry Date
Mouse
1. Check the Expires after box and specify the date and the time when you want the message to become
unavailable.

Flagging Messages
The user can flag a message to remind them to follow up the message or they can flag a message with a request for the
recipient to follow it up. When a message is flagged, an icon displays in the Flag Status column of the right of the View Pane.

➢➢ To Flag A Message:
Mouse
1. From the View Pane, click theFollow up flag in the tags group on the home ribbon
2. From the menu make a choice asto when you wish to follow this email up.
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➢➢ To Add A Reminder To A Flag (For Myself):
Mouse
1. Select the message you wish to flag in the view pane.
2. Click the Follow up flag in the tags group on the home ribbon

3. Choose Add reminder from the menu.
4. Set the options you require in the dialog box.
5. To assign a due date to the flag, in the Due date box select the date required.
6. Choose OK.
•

By default, overdue items appear in red.

Download free eBooks at bookboon.com

79

Outlook 2010: Part I

Message Options

➢➢ To Add A Reminder To A Flag (For Recipient):
Mouse

1. Create a new message
2. Enter message and recipients
3. Click theFollow up flag in the tags group on the home ribbon
4. Choose Add reminder from the menu.

5. Untick flag for me and tick flag for recipients
6. Set the options you require in the dialog box.
7. To assign a reminder to the flag, in the reminder box select the date required and the time
8. Choose OK.
9. When the recipient receives a message with a flag, a comment on the purpose of the flag and the reminder
time will appear at the top of the message.
•

By default, overdue items appear in red.
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➢➢ To Flag A Message As Complete:
Mouse

1. Right-click over the flag symbol next to the message you wish to flag as complete and choose Flag
complete from the shortcut menu
Or

.
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Menu
2. Open the flagged message.
3. Click the follow up flag.in the tags group
4. Check Completedand click OK.
Completed items appear with a tick in the flag column
➢➢ To Clear A Flag:
Mouse
5. Right-click the flag symbol next to the message whose flag you wish to clear. Choose Clear flag from
the shortcut menu.
Menu
6. Open the flagged message.
7. Click the follow up flag.in the tags group
8. Click Clear Flag.

Flag Colours
By default any flag is for today, in the follow upflag options in the menu you are able to adjust that for tomorrow or next
week. Etc.the flags will have different colours dependent on the option chosen.
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➢➢ To Set Different Colour Flags For Messages:
Mouse
1. Select the message you wish to flag in the view pane.
2. Click the Follow up flag in the tags group on the home ribbon
3. Make a selection from the flag types and the flag will appear as before but as a specific colour.
•

Flags of this nature are easier to group and locate within your mail folders.

Flags And To Do Pane
When flags are applied to emails either by yourself or the sender, an email with aflag becomes something to do. This type
of email could be classed then as a task to perform at some future date. The to do pane lists all tasks within your email
folders. Whether the task is an email in origin or a task in your task folders.

When you receive or create a flagged email it will appear in the to do section of the to do pane near the bottom. As you
complete the tasks just left click on the flag for the task to be completed and to disappear from the to do pane.
It does not matter where you put the email in your email folders the to do pane searches for flagged emails no matter
where they are in your mailbox.

Colour Categorise Messages
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Another method of helping you to be more efficient is the use of colour categories. These will enable you to colourise your
emails based on certain criteria you set or for you to manually define the basis on which tey are applied.
By default categories only have a colour label such as blue, red, green etc but as a colour category is first used you are
asked to define the label for that particular category such as “business” or “personal” maybe a project name or such.
The categories work into all aspects of outlook, the calendar, tasks, notes etc.
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➢➢ To Apply A Category
mouse
1. Select an email or several if you prefer.
2. Click on the categorise button in the tags group on the home tab.
3. Select a colour category.
4. If it is the first time a category has been used a window will appear asking you to rename it.

5. Enter a name and apply a shortcut cut key if you desire
6. Click on yes.
7. As you can see when the category is applied to an email a coloured square will appear next to the flag to
easily identify it later and in the reading pane a coloured bar with the category label appears in the message
header. (This is how it would appear in an open mail)
•

Remember categories apply to all parts of outlook we look further into categories later to enable automatic
categorising.
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Autosignature
An e-mail signature consists of text and/or pictures that are automatically added to the end of an outgoing e-mail message.
You can create custom signatures for different types of audiences. For example, use your first name for messages to friends
and family, or your full name and e-mail address for messages to business contacts. You can also use a signature to add
“boilerplate” text, such as an explanation of how you want others to respond to your messages.
➢➢ Create A Signature For Messages
Mouse
1. Go to backstage view (File Tab) click Options, and then click the Mailbutton on the left
2. On the right look down and click the signatures button a dialog will open.

3. To create a new signature click on the new button.
4. Under Signature, click Signatures, and then click New.

5. In the New signature box, enter a name. and click ok
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6. Using the formatting tools to choose a format for your signature.
7. In the main area type the text you want to include in the signature. You can also paste text to this box from
another document.
8. The formatting options will not be useful if you use plain text as your message format.
9. To add an electronic business card - vCard - to the signature, click the business card button, select a vCard
from the list, or click New vCard from Contact.
10. Once you’ve created the signature, you can insert it in all new messages, in all messages you reply to or
forward, or just in a specific message.
11. Click Save to save the signature and Ok to close the window
➢➢ To Automatically Have An Autosignature In Each Created Message.
mouse
1. Go to backstage view (File Tab) click Options, and then click the Mail button on the left
2. On the right look down and click the signatures button a dialog will open.
3. On the top right choose a signature from the drop down list for new messages

4. You may also choose one for replies and forwards. It does not need to be the same one.
5. Click ok to accept your choices and close the window
6. Creating any new message now you will see contains the signature you selected.
➢➢ To Manually Insert A Signature
mouse
1. Create an email as previously instructed.
2. Move your cursor to the location you wish to see your signature appear.
3. Go to signature in the include group on the message tab
4. Click on the drop down arrow and select the signature you wish to insert.
5. Signature is inserted.
You may create many signatures for different occasions and recipients. You may fulfil more than one role within your company
any dependent upon the occsion and recipient, you may need to have different information within you’re your autosignature.
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Message Icons
Each message in the View Pane contains a Message Icon, the name of the sender, the message subject and the date and
time the message was received. The icon next to each message communicates information about the received message:

Message Icons

Description
High Importance Message

Low Importance Message

Unread Message

Read Message

Notification Of A Delivered Message

Notification Of A Read Message

Notification That A Message Was Not Delivered

Notification That A Message Was Not Read

Message With An Attachment

E-mail Accounts
You can get the e-mail service you need by adding an e-mail account to Microsoft Outlook using the information provided
to you by your administrator or Internet service provider (ISP). Depending on your needs, you can add several e-mail
accounts to a single Outlook user profile. For example, you can add a Microsoft Exchange Server account to handle your
business e-mail and then add an Internet e-mail account, such as Hotmail, to handle your personal e-mail.

Outlook Supports The Following Types Of E-Mail Servers:
•

Microsoft Exchange Server

•

Internet E-mail: POP3, IMAP, HTTP

•

Additional Server Types
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To Get Started With An E-Mail Account, You Need To Tell Outlook:
•

Type of account (Exchange Server, POP3, IMAP, HTTP, or other)

•

Name of your incoming server and outgoing server

•

Your user name Your e-mail address (for example: username@provider.com)

•

Your password

Add An E-Mail Account (Pop3)
➢➢ To Add An E-Mail Account
Mouse
1. Go to backstage view (File Tab) click Info.

2. Click add account
3. Enter your name.
4. Enter your email address in full.
5. Enter your password
6. Reenter your password.
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7. When you click next outlook 2010 will automatically connect to the internet and locate your email server
and port settings and set up your pop3 internet account within outlook.
8. Click next
9. Test account settings to complete adding the account.
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Unless specified by your ISP, all server and address entries are typed in lowercase letters. Some ISPs require a
combination of lowercase and uppercase letters for passwords to add further security. For example, passWorD.
Check with your ISP to see if it requires a case-sensitive password.

•

If you want to configure additional settings, such as how you want your computer to connect to your e-mail
server, click More Settings. Otherwise, click Next and click Finish. The new mail account will appear in the
Navigation Pane.

•

Unless your ISP has indicated that your service uses Secure Password Authentication (SPA), do not select the
Log on using Secure Password Authentication (SPA) check box.

Add An E-Mail Account (Exchange)
➢➢ To Add An E-Mail Account
Mouse

1. Make sure Outlook is not running
2. Go to the control panel and double click on the mail icon.
3. Choose profiles a dialog will open
4. Add a new profile, Give the profile a name called exchange when asked, a new dialog will open.
5. Make the manually configure server settings or additional server types
selection.
6. Click next, select microsoft exchange or compatible service.
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7. Click next,enter a server name and a user name.
•

If you are to connected constantly to the network then untick use cached exchange modethis would
set up offline folders to be used when not connected to the network such as on a laptop.

8. Click check name.
9. You may be asked for an administrator username and password to access the server and confirm the
exchange user account. If your administrator has given you a username and password to confirm this then
enter and proceed.
10. The server name and username will become underlined
11. Click next to see that your email account has been created.
12. Start outlook and choose appropriate profile.

Editing Or Removing An E-Mail Account
➢➢ To Remove An E-Mail Account
Mouse
1. Go to backstage view (File Tab) click Info.
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2. Click account settings and from the menu choose account settings a dialog will open.

3. Click the e-mail account you want to delete, and then click Remove.
4. Click Close.

Make An E-Mail Account The Default
If you are using more than one account, you can specify which account is the default so that it will be the first account
to be processed. Microsoft Outlook sends your messages using the default account unless you click the Accounts button
(next to the Send button) on the message to choose another account to use for that message.
➢➢ To Make An E-Mail Account The Default
Mouse
1. Go to backstage view (File Tab) click Info.
2. Click account settings and from the menu choose account settings a dialog will open.
3. Click the e-mail account you wish to make the default and clickset as default.
4. Click Close.
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Have Replies Sent To A Different E-Mail Account
You can specify a different account to be used when a recipient sends a reply to your message. For example, if you send a
message and then go on holiday to visit a friend, you can tell Microsoft Outlook to send replies to your message to your
friend’s account.
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➢➢ To Have Replies To Your Messages Sent To A Different Account
Mouse
1. Go to backstage view (File Tab) click Info.
2. Click account settings and choose account settings a dialog will open.
3. In the list, click the e-mail account that you send the message from, and then click Change.
4. Click More Settings, and then, in the Reply E-mail box, type the e-mail address of the account that
you want replies sent to.

Change An E-Mail Account Name
An e-mail account name is the name that appears in the list of e-mail accounts you have created. If you use more than
one e-mail account, when you create a new message you can click the Accounts button (next to the Send button) to see
the list of accounts and choose which to use to send the message.
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➢➢ To Change A E-Mail Account Name
Mouse
1. Go to backstage view (File Tab) click Info.
2. Click account settings and from the menu choose account settings a dialog will open.
3. In the list, click the e-mail account you want, and then click Change.
4. In the Your Name box type a new name for the account.
5. You can name the e-mail account anything you want.

6. Untick the test account checkbox and Click on next when finished
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